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Description 

This class will walk through all aspects of Project Navigator within AutoCAD Architecture 
software. We’ll cover the differences between using Project Navigator versus the Sheet Set 
Manager; how different aspects of Project Navigator will help create a more efficient workflow; 
how to use Project Navigator to create a more comprehensive project; and how to take those 
projects and create 3D renderings. 
 

Speakers 

Tiana Dame studied Mechanical Engineering in college and started out her career as a designer 
and then became a liaison between designers and machinists in the Aerospace field. Using 
CAD software became part of her day to day and began to gather expertise in AutoCAD and 
Inventor. Then she made the decision to go from user to supporting the products she knew so 
well. Since joining Autodesk as a Technical Support Specialist, she has added more products to 
her list of expertise, with major focus on AutoCAD Architecture and MEP.  

Dominique Spicher started out working as an architect for several years in Germany. After 
working on many projects and competitions and gaining experience of the many areas of the 
building industry, transitioning from a user to the software development side as a Technical 
Support Specialist for CAD software came natural in 2012. Since then he has been supporting 
various different CAD applications throughout the following years and is now part of the team 
supporting AutoCAD with a focus on AutoCAD Architecture and MEP.

Learning Objectives 

• What does Project Navigator do? 

• Learn about how sheets, constructs, and views can help productivity 
• Learn about streamlining projects 

• Learn how to create 3D renders from Project Navigator 
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Introduction 

Architects and designers are usually working on multiple projects on a day to day basis, and 
each project has very detailed components. Often times, all of these very detailed projects also 
have teams working on every part, which can lead to disorganization. Autodesk’s software 
offers many ways to organize your projects so that they are manageable. The design software 
that each team member uses can determine whether this process is seamless, or full of errors.  
Within AutoCAD Architecture you and your team can create streamline projects using Project 
Navigator and all of its components.  
 
The example in this class is a Small Office project – which was created with AutoCAD 
Architecture and utilizes all of the components within Project Navigator. We will walk through the 
starting of a project to rendering straight from AutoCAD Architecture.  
 

How to Start a Project 

Project Browser 
In order to utilize everything Project Navigator has to offer you have to first create a project.  
 
1. Upon opening AutoCAD Architecture you will see the option to Open Project, select that 

option.  
2. You will then see a dialog box appear that is known as the Project Browser. The project 

browser does just as its name suggests, it allows you to browse your projects.  
3. Within the Project Browser there is a New Project icon in the lower left hand corner or 

the dialog box, click on that.  
4. From here you are prompted to add a Project Number, Name and Description. It would 

be best to create a project with an ID and Name that would allow others on your team to 
be able to easily recognize.  

5. Once the Project is created you will see an APJ file appear with your Project name 
appear in the dialog box. If you select the project and then right click you will see the 
option to Set Project Current, select that and the project will then appear in bold. One the 
project you need is in bold you can close the Project Browser.  
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AUTOCAD ARCHITECTURE PROJECT BROWSER 

 
Now for this class we are using a project that is already created, so you can skip the above 
steps if that is your case and go right to step 5, where you just want to make sure the project 
you are using is Set Current. Once you have either an existing or new project set current you 
will have access to the Project Navigator.  
 

What does Project Navigator Do?  

Overview  
Project Navigator is not a clever name for this tool, it does exactly as it says, allows you to 
navigate your projects with ease. It is broken down into Project, Constructs, Views and Sheets. 
Which in this portion of the class we will go into detail about what each one of these sections 
are and how they can help you organize your project. 

Project  
The Project subset in Project Navigator is the most straight forward. It is the overview of your 
project. It contains, the ID, Name and description you gave when you created the project. It also 
has the Levels and Divisions sections where you can list how many levels you may have.  
 
Levels, are how many floors are within a building. In this class example there are 4 working 
floors of the office, and then a level for the foundation is assigned and a level for the stair wells. 
Levels will show the elevation and description of each floor that is assigned for the project.  
 
Divisions represent wings or plan areas within a building. Divisions do not need to be assigned, 
they are there if the project needs defined wings or plan areas. Divisions often times are the 
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Main Building, which would leave out the foundation and roof, etc. and only focus on the area 
that is considered the “working” or “livable” areas.  
 
These are the properties that are displayed within the Project tab within Project Navigator, 
however if you choose to edit any of the other project properties you can do so from this tab as 
well. In the upper right hand corner of the Project palette is the Edit Properties icon. Here you 
are able to edit many project properties. You also have the icons to edit the Levels and Division 
properties on the right hand side of each subsection. Overall, the Project tab is where you can 
make higher level changes to the project as a whole.  
 

 
PROJECT NAVIGATOR: PROJECT TAB 

 

Construct 
Constructs are the most detail oriented, and arguably important, part of Project Navigator. They 
represent the various specifically build components of the building. Usually multiple constructs 
are assigned to each level and contain the fully built objects, such as doors, windows, spaces, 
etc. In this class we will have our project broken down into Architectural, General, Interiors, Site 
and Structural constructs. 
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PROJECT NAVIGATOR: CONSTRUCTS TAB 

 
Now there are elements that are referenced by constructs within the project and are comparable 
to blocks, however they specifically hold objects that repeat within the building. In this class we 
will not be diving into elements but it is important to note that these elements are reference by 
constructs within projects. 

 

Views 
Views reference your constructs but often include specific notes, tags, dimensions and other 
annotations. Views often times get drag and dropped to create sheets. Overall your Views are 
where your floor plans begin to come together. Your Views have the most data within them, as 
they hold the data from your constructs, as well as, all of the annotation needed. Views also are 
the home to any schedules or spaces you assign, as well as, any and all tables with the project.  
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PROJECT NAVIGATOR: VIEWS TAB 

 

Sheets 
The Sheets tab within Project Navigator is where your sheet sets are kept. Now, a sheet set is 
an organized collection of sheet files, created from several drawing files and can be published, 
transmitted, and archived as a package. Some may know the Sheet Set Manager that is within 
AutoCAD poducts, this is similar to that, we will get into the details later in the course. However, 
what is important to take away from this is that the sheet sets allow you to easily share projects. 
Sheer sets allows any changes made to the sheet properties, sheet set properties and callouts 
be automatically updated across the sheets in the set.  
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PROJECT NAVIGATOR: SHEETS TAB 

 
Most often we see sheets containing views that have been created and brought onto the sheet. 
It is used mostly for plotting and sharing the projects. For instance and entire sheet set could be 
plotted to PDF to be shared with teammates who may not have access to AutoCAD but need to 
see the plans.  
 

Wrap Up 
Now that we have the basics down and have a better overall understanding to what the Project 
Navigator can do for our projects, lets get into the bulk of the class, which really focuses on how 
this tool can be used to streamline and organize your projects.  
 

 

How can Constructs, Views and Sheets improve organization? 

Overview 
We have descried what exactly these constructs, views and sheets are, but knowing what they 
are and knowing how to utilize their tools well are two different conversations. In this class we 
will be demonstrating how these tools can be used together for an organized project.  
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Creating Constructs and How to Use Them  
Now creating constructs within the Project Navigator is pretty straight forward. Within Project 
Navigator to add a construct you just have to select Construct and then right-click and you will 
see the Add Construct dialog box appear.  
 

 
ADD CONSTRUCT FROM PROJECT NAVIGATION 

 
One of the most important sections that must be added here is the Drawing Template. If you 
have customer templates to use, they must be pathed correctly here in order for it to reflect in 
your construct. Once the construct is created you have a new drawing ready to have added 
whatever your project requires.  
 
Now, I have seen many projects and have worked with many customers who utilize project 
navigator, and the most common breakdowns are Architectural, Interiors and usually there is a 
General or Base construct that is simply the building outlines/boundaries.  
 
Once you have everything created within your separate constructs, ex. Placed your walls, 
windows, doors, etc. You are able to move onto the next phase or step within Project Navigator.  
 

Using Constructs to create Views 
Since you have all of your constructs organized and ready to go, a good way to create your 
views is to mirror your thinking when you created your constructs. For example in this project we 
have very similar constructs to views.  
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COMPARISON OF VIEWS AND CONSTRUCTS 

 
As you can see they overlap almost entirely at a higher level in the tree. The Site and General 
constructions are not within the views, as theses hold boundaries and outlines only and can be 
inserted as blocks in the project instead of dedicating full Views for these.  
 
Now as discussed previously Views hold all of your annotative data, as well as references your 
constructs, so a lot of information goes into the building of these views. When adding a view you 
have options as to what kind of view can be created, which is based off of what you need to 
add. Either way you see the same dialog box below and the same information needs to be 
added in order for the view to be created, again make sure your template is pathing to the 
correct location.  
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ADD A VIEW DIALOG  

 
 
To get to this dialog box you need to select View in the Project Navigator and right click, you will 
see the option to Add New Drawing or Add New Category, if you add a new category you will be 
adding a sub-view to the tree instead of the hierarchy of the views. Once you fill out this first part 
of the Add View Dialog box is where you are able to reference what Level you are working on 
and then you will see your list of Constructs that you are able to reference. 
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REFERENCE LEVELS IN VIEW 

 
REFERENCE CONSTRUCTS TO ADD VIEW 
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Now once you have all of your Views set up, and referencing the levels and constructs needed 
in Project Navigator you can then add what you need in order to finish your floor plan, 
annotations, callouts, schedules, tables, etc. Once you have everything you need to complete 
your floor plan added to the views it is nearing the time where you want to transmit your project.  
 

Using Views to Create Sheets 
 
The same steps are taken when first setting up your sheets, you will need to select Sheets, right 
click and New. This will bring you to the New Sheet dialog box where you will need to fill out 
your data. Now the sections within your sheets should match your Views as far as labeling goes 
in order to keep the project organized.  
 

 
NEW SHEET DIALOG BOX 

 
In order to create the sheets to be the best representation of your project, dragging them from 
your Views onto your Sheets is the best way to ensure consistency  
 
Once the sheets are created you can publish the sheets in many different forms to be shared 
out to teams, internal or externals.  
 

Rendering your Project to 3D 

Once you have all of your Constructs, Views and Sheets all set and ready you can create your 
3D View and then render it to the cloud where you will be able to see your project in true 3D. 
The Render tab is located on your Ribbon and has all of the settings needed to send the render 
to the cloud.  
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Concluding 

Now that we have gone through how to streamline your project you are able to use Project 
Navigator to navigate your project. Happy designing!  


